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Welcome to the Designer's Guide

Welcome to the DataEase Designer's Guide. This book explains how to create databases, design documents, and use the
following special application development features.

91 Application Catalog
9 Toolbars
9 Menus
9 Data Model
I Layout Options
9 Document Objects
| Database Syles
9 Command Buttons
I Custom-Defined Functions
91 SQL Connectivity
This online book includes an introduction to DataEase application development concepts, guidelines for using DataEase as

a front -end tool in a Client -server environment, and reference informa tion for all the application and database design
features of DataEase.

This book is written for professional application designers, system administrators, and experienced users who may want
to design their own applications.

If you are not familiar with DataEase, we recommend that you begin by performing the hands -on lessons in the DataEase
Quick Start Guide (QSG).

If you are an application designer, system administrator or experienced user who wants to extend the power of your

applications by creating DataEase Query Language (DQL) programs, you'll find the information you need in the DataEase
DQL Programmers Guide
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Chapter 1: An introduction to Application design in DATAEASE, explaining terms and concepts.
Chapter 2 : Principles of Database design

Chapter 3: The FILE Menu all the options explained.

Chapter 4: The EDIT Menu all the options explained .

Chapter 5: The VIEW Menu all the options explained .

Chapter 6: The OBJECTS Menuobjects explained .

Chapter 7: The DOCUMENT Menuproperties, security, Custom Tabs and Menus.
Chapter 8: The APPLICATION Menuapplication preferences, SQL, Maintenance.
Chapter 9: The Window Menu- how to arrange windows on screen.

Chapter 10: The Help Menu- summary of available Help.

Appendix A : Foreign Databases and Client-server.

Appendix B : Custom Defined Functions.

Throughout the DataEase manuals, we've used the following typographical conventions to make the documentation easier
to under stand.

Term Typeface Used Example

Glossary Term Italic Data Model

Menu Option Bold File>>Open

Function Key Uppercase F7 DELETE RECORD
Document/Table Name Uppercase MEMBERS

Field Name Small Capitals FIRST NAME

DQL Term Bold Lowercase highest of

SQL Command Uppercase CREATE TABLE

Glossary terms with special meaning in DataEase are printed in italics the first time they occur in the text and are
defined in the on -line glossary available in Help.

Gettin g Help

The Help menu on the right end of the Menu Bar is used to access the DataEase Help system. The DataEase Help system is
a separate hypertext program that runs in its own moveable, resizable window and operates concurrently with DataEase.
This program uses many of the standard navigational tools the Windows Help system provides.

To quickly access the DataEase Help system, press F1 HELP. To display specific help on a menu option, dialog, or Toolbar
button, press Shift + F1 CONTEXTSENSITIVE HELP.

Sample Application

Club ParaDEASE the sample application shipped with DataEase, is based on a fictitious travel industry organization. This
application is used throughout the DataEase documentation to illustrate data en try, application query, form/report
design, and other important procedures, and help you learn how to use a DataEase application in a realistic context.

Our sample application, Club ParaDEASE runs an expanding set of resort clubs situated in exotic locale s around the
world. Each club provides the setting for a weeklong vacation package, with air/land travel arrangements,
accommodations, and other hospitality services included at a discount price. Special facilities, equipment, and intensive
training worksh ops are offered for various sport activities at each club.

Club ParaDEASE uses forms to enter, update, and report information about Clubs, Activities, Members, Reservations, and
other aspects of club business. The DATAEASE Quicltart Guide explains Club ParaDEASE in detail. An example document
- The CLUBS form- is shown below.
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CLUBS Previous

Next

Club ID | 90002
Room: 148

New

Save

Delete

Activities

Reservations

Club Name |caravelle Telephone (590)88-24-62

Street: 1900 Bel Aire

City: Guadeloupe Country Fr. West Indies

Description:

With its unsurpassed white beaches and
glittering emerald seas, Caravelle, on the
Grand-Terre section of Guadeloupe, is a
favorite retreat for honeymooners. Ask
about our special discount offer.

Caravelle

Activities
e <
E%*%J

Sailing Riding Skydiving Scuba Tennis Football

0 ]|

&

Viewing Documents
User View

User View is the data-oriented environment of DataEase. In User View, you can view data in a single record or multiple
records, enter new records, modify existing records, create reports, and run previously defined reports. User View also
lets you use Query By Form techniques to find specific records in a form. The figure below summari zes the menus

available when you view a d

In Userisw .. - E —
Al4le]m 4 » § MIE T[S |&
File menu options let you create, Window menu options let
open, save, and print documents, you automaticalby arrange
and exit the application. windows and icons on

Edit menu options

actions, cut, paste, and copy data,
save, modify, and delete records,

and copy data into
programs.

View menu options let you dizplay
single or multiple records, or view
a specific set of records.

Goto men

records, display a form related to the
current form, and copy data from one

form into

Query menu options let you select
and sort records, and run reports.

ocument in User View.

File Edit Wiew Goto Query Application  Window  Help

the desktop and switch

to another window.
Help menu options let
you access the online
Help sy=stem.

let you undo

other Windows

u options let you browse

another.

Applications menu options let you open or
close the Application Catalog, create
relation=hip= between forms, install custom
functions, and perform system administration
tasks.
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Designer View

Designer View is the application design environment of DataEase. In Designer View, you create the record entry forms,
custom menus, and reports used in your application. Desig ner View lets you build special features into your application,
including image fields, custom buttons, and direct links to other Windows applications (such as word processing,
spreadsheet, and presentation graphics programs).

In Designer‘iew ..  File Edit View Objects Document Application ‘Window Help

F@R“x\JﬁﬁﬁﬁﬂﬂQ@E;

File menu option Iet_].ruu create, open, window menu options let you
save, delete, and print files, and exit automatically arrange windows

the application. and icons on the desktop.
Edit menu options let you undo actions,
cut, paste, and copy objects, automatically
re=size and align objects, and create data exchange
links with other Windows programs.

Help menu option let you access
the online Help system

The View menu options let you display and edit
report headers and footers and turn on the Toolbar,
Grid, and Rulers.

The Objects menu contains the tools used
to create fields, subforms, buttons, images,
and styles. Styles speed layout and give
documents a uniform look.

Document menu options let you set a
document's initial size and position when
opened, its tab order, security level, and
other properties.

Application menu options let you open or close

the Application Catalog, create relationships

between forms,create Custom-Defined Functions,

link an application to multiple databases, set application
preferences, and perform system administration tasks.

Although most menus on the DataEase Menu Bar are available in both views, each view has some unique menus as well as
its own set of command buttons on the Toolbar.

The Toolbars

The User View and Designer View Toolbars are shown below.

Designer View (click here for a more detaile d description)

|0 YANGD. Q Q

LEET AR @eA@S A00r @
PEHAFD0 B EMAE k=W E

User View (click here for a more detailed description)

VWO ANADRE ESESEH M6
EE SR AQAAAB T A
AN SR DOE®

Exiting DataEase
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To Exit DataEase and return to Windows, choose File>>exit. DataEase prompts you to save any changes you have made in
your DataEase session before exiting.

Copyright and Trademarks

This manual supports DataEase version 7.2 and higher.

Publication Date: October 2009

© DataEase International Ltd. All rights reserved.

DataEase is a registered trademark, and the symbol and slogan are trademarks of DataEase International Ltd.

All other trademarks and registered trademarks belong to their respective holders.

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any m eans:
electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of the publisher.

Sales and Support

Rosemore

Heaton Grange Road
Gidea Park

Romford

RM2 5PP
Sales phone: +44 (0) 208 1237 3 65

Creating Applications in DATAEASE

DataEase is a powerful relational database system that provides the enhanced graphical interface, dynamic data
exchange, and multi -tasking capabilities available in the Microsoft Windows environment. In addition, DataEase features
transparent connectivity to multiple SQL and foreign PC databases through industry standard ODBC drivers..

This section provides a brief overview of the capabilities of D esigner View as well as the design tasks involved in creating
a DataEase application.

DataEase is arelational database system. A relational database system stores data in multiple tables that are linked by
relationships that permit efficient data retrieva | and manipulation.

Many of the following examples are taken from the DataEase sample application called Club ParaDEASEan imaginary
Travel organization. This application contains a number of database tables, including RESERVATIONS, MEMBERS and
CLUBS. Themaginary users of this application spend a lot of time taking holiday bookings, and since Club ParaDEASE
data is stored in a relational database, whenever a record is entered into the RESERVATIONS form, DataEase can
automatically look up and retrieve mos t of the required information from the related CLUBS and MEMBERS tables.

As a relational system, DataEase maintains data integrity, i.e. the data throughout the database maintains its accuracy
and consistency. For example, if you need to modify data duplic ated in several records (such as a change of address),
you need only make one modification. Related records are automatically updated in each location.

3 oooon3 Christino Laura 4905 Radford Avenue
94 oooo4 Williams Laura 17 Corinthian Way
5 nopos Riggs Cynthia 11 Lilac Drive

Referential Integnty. Alter a value - such asz an address - and thiz zame change will be automatically applied to
related records. [ this example Cynthia Rigg's address iz changed in the MEMBERS Form from 170 Lilac Drive"
to 17 Lilac Drive". This change iz automatically refelected in the RESERWVATIOMNS Faorm.
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Designer View is used to create database applications. Application design begins with conceptualizing and normalizing
database tables, and defining relationships between tables. These tasks are discussed in detail in the next chapter.

Once conceptualization of your database is complete, the actual design of database tables, def inition of the fields, and
design of document layouts into which users enter new data is done in Designer View.

Application design includes designing database tables, forms, reports, menus, and procedures. The forms, reports,
menus, and procedures are called documents in DataEase.

The four Document types of a DataEase Application are FORMS, REPORTS, MENUS and PROCEDURES. They are used as
follows.

A DataEase application is a collection of database tables and a set of for ms, reports and menus that address a particular
business need. An organization may need to use several applications, one for each system in which data is organized and
accessed.

For example, an organization may find it efficient to create several separate = DataEase applications. An example is shown
below, where four Departments of a single organization choose to construct five applications.


















































































































































































































































































































































































































































































































































































































































































































